
About Inspectware 

Welcome to InspectWare  
Welcome to Inspectware!  InspectWare provides Home Inspection Software to the Home 

Inspector so they can create electronic inspection reports with pictures for printing or 

emailing. Unlike other reporting software tools, our report framework is completely 

flexible and 100% customizable. And we do it FAST!   

 

InspectWare  

100 Kennett Road  

Wilmington, DE 19807 

1-877-277-8844 

 

 
 

 

 

 
 

Software Updates 
To find out if software upgrades are available, please contact your Inspectware Vendor. 

Low Power Warnings 
It is recommended that laptop users heed low battery warnings immediately.  Laptops 

shutting down while editing a Home Inspection Report can corrupt the database. 

Send Suggestions 
Please send suggestions to reliablehomeinspections1@gmail.com  Your input is always 

appreciated.

 

 

mailto:jwk@inspectware.com


Getting Started 

Initial Setup 

Add company information 

 
At installation, you are automatically prompted for your Company Information.  To 

change this later, click on the View menu and select Preferences.  The center tab is 

Company Information.  A company logo can be included with the company logo box.  



Software Registration 

 
To register this Inspectware software, click Help, and select Registration Info and make a 

note of your Serial Numbers.  Contact the office at 877-277-8844 to purchase License 

Keys.  Enter the e-mail address to which the software is licensed and click Internet 

Download or manually enter your License Keys for both the Home Inspection Software..  

A popup box will automatically inform you of the status of your license when you select 

close. 



File locations for InspectWare 5 and 5/Tablet 

 

 
Upon installation, there will be a Reports folder added to the User Folder and a white 

sheet of paper will be added to the Desktop. After install, simply delete the file and next 

time you start the software, a new InspectWare reports file will appear and will be a short 

cut to the new location in user/InspectWare/reports. You file must end with hit.dx 

(example:  report_data_hit.dx) and will be located or should be placed in the 

user/InspectWare folder. 

 

 

Screen Auto Resize  

 

 
 

By selecting Auto size display or the auto size button the screen will rebuild and fit the 

current size or orientation of your computer or tablet. When it reopens the client and 

report you were working on will be reopened. 



Search Records 

 
In the Open Inspection Records window, you can search the existing records by clicking 

the Search button .  You can search by Last Name, First Name, Address, City, 

State, Zip, Phone Number or Comments.   

 

 



Edit Client Information 

To edit the client information, click Addresses and select Clients, or in the Open menu, 

click the document button beside the Client line. Select the client you wish to edit from 

the drop-down menu, Change the information, and select Save. 

Edit Inspector Information 

To edit the inspector information, select Addresses and select Inspectors, or in the Open 

menu, click the document button beside the Inspected by line.  Select the inspector you 

wish to edit from the drop-down menu, Change the information, and select Save. 

Edit Referrals Information 

To edit the referrals information, click Addresses and select Referrals, or in the Open 

menu, click the document button beside the Referred By line.  Select the Referrer you 

wish to edit from the drop-down menu, change the information, and select Save. 

Edit Company Information 

To edit your company information, select Tools, select Preferences and open the 

Company Info tab.  A company logo can be included by browsing for the logo in the 

Company Logo Path box.   

 



Photos 

Add a Photo 

To add a photo to your Inspection Report, click the Comment button, and click the Snap 

Shot button.   Click on the folder open button and browse to the photos you 

want to insert.  

 

 
Select the photo you want by clicking on it once.  It will appear on the right side of the 

Select Image box, and the name will appear in the Image List Editor column in the center.  

All Photos included in the Image List Editor will be included in that subsystem.  Photos 

can be removed by clicking the Delete Selected button.  Photos can be reordered by 

highlighting their name in the Image List Editor box, and clicking the Up and Down 

arrows. 



 

Highlight photos 

 

To add highlights to a photo, use the Drawing Options in the center of the Select Image 

box.  To create an arrow, click and drag on the picture.   

 
To change the color or the line width of the arrow, click the preferences button and select 

a new line, width or color.  Click Ok.  To change to a circle or box, click on the 

corresponding check box.   

 

 
 

To undo your changes, click the clear arrows button.   

 
 

To remove or replace photo numbers, click the Number Photos checkbox. 

 

Add multiple photos to one subsystem 

Proceed as with adding one photo, but select two photos.  The list of included photos can 

be found in the center of the box, in the Image List Editor. There is a maximum of five 

photos in a subsystem recommended.  More photos can be added, but a pop-up box will 

warn that this has been exceeded, and these pictures may be cut off on the final reports.  



Pictures may also be removed by highlighting their name and clicking the Delete 

Selected button.   

 

 

Cover Photo/COVERPAGE 

To add a cover photo, add a photo to the System called COVERPAGE.  “COVERPAGE” 

must be the exact file name to put the photo on the cover page instead of in the report as a 

subsystem.  Subsystems can be added to cover page but may result in multiple cover 

pages, and are not recommended. 

 

 



Inspection Walkthrough 

Create New 

To begin an Inspection, open the File menu and select Open Inspection Record,  

 

or simply click on the magnifying glass button.   This will open the Inspection 

Records box.  Click on Create New to begin a new Inspection Record.   

Record ID 

In the box at the upper right corner, enter the record number.  This will maintain the 

Inspection Records organization.   

 

Referred by 

Use drop down box to select the Referrer, or click on the blank paper button to the right 

of the Referred By box, click New, and enter information for the Referrer. 

 

Inspected by 

Use the drop down box to select the Inspector, or click on the blank paper button to the 

right of the Inspected By box, click New, and enter information for the Inspector. 

 

Inspection Report Comment 

The time and date were automatically inserted in this field when the new Report was 

created.  Add any other comments applicable. 

 



 

Client info 

Enter Client Information including Last Name, First Name, Address, City, State and Zip.  

Omitting Client Information can cause the database to become corrupted or searching to 

be impossible.  Telephone and Mailing Address/Comments are optional.  

 

 
 

Save 

Click the yellow highlighted Save button. 

 

Open 

Your new Report will now be at the top of the list in the Choose an Inspection Record 

box.  Click on it to select it, and click Open, or simply double click on the file, to open it. 

 



Complete report, flag for picture or further comment 

Include Front View 

Click on the PHOTO box in the Front View of Home line.  This automatically includes 

the system or subsystem in the Report.  Click on the Flag to the left of the comment 

button, to Flag it to add a photo later. 

 

Something must be in type description (subsystem types) first then 

Inspect the home, and fill out the report.  For each system and subsystem, first click on a 

type in the type description section.  This will automatically include the subsystem in the 

report. 

 

Something must be in opinion 

Subsystems are automatically included as a check.  If the system is defective in any way, 

select the level of defect in the Opinion column. 

 

Excluding systems and subsystems 

To exclude a subsystem, select the N/A Opinion.   

 
If an entire system is not applicable to the Inspection, click on the system header and 

click the Make Current Subsystem Not Applicable button.   

 

System buttons 

The system bar at the top, just below the menu bar begins highlighted.  Each highlighted 

system is incomplete.  You can click on a highlighted system to quickly jump to that 

system.  The system bar buttons gray out when the system is completely inspected. 

 

When something is marked as a defect, it automatically brings up the 
comment window 

When a subsystem is marked as defective in the Opinion column, the comment window 

opens automatically.  



Comment Box 

Comment Pool 
Specify the issue with the subsystem in the Comment Window either by double clicking 

one or more of the Comments in the Comment Pool,  

 
or by entering your own comments into the Comment box and by using the Frequently 

Used Items Box explained below.  If there is a Comment in the Comment Pool for 

another subsystem in the same system, or in any other system, click on the System or All, 

to show the Frequently Used Comments for the entire System, or for all Systems.   

 

 
 

Sorting Comments 
All Comments in the Comment Pool can be sorted with the buttons in the Pool Order 

section to the right.  To move one particular comment up or down, highlight that 

comment, and click the red up or down arrow.  To sort the comments alphabetically, click 

the ABC button.  To permanently save your ordering changes, click the vertical Save 

button that appears at the right of the up and down arrows when you have made changes. 

 

 Frequently used items drop box (apartment unit, 
location, etc) 
The Frequently Used Items drop box can be used to add items you often use in multiple 

subsystems without adding them to the Comment Pool for each subsystem they are used 

in, and without having to browse all comments to find it each time.  It can also be used to 

refer to certain areas, or to different rooms or units within the same inspection, easily.  

Selecting the item from the drop box will automatically add it to the end of the comments 

in the Comment Box. 



 

User Defined Comments 
Any comment can be typed into the Comment box.  It can be added to the Comment Pool 

by clicking the Add to Pool button.  Comments can also be removed from the pool by 

highlighting them and clicking the Remove button. 

 

Hot Scan  
Selecting Hot Scan keeps you from closing the comments box with the Opinion marked 

as Satisfactory if there are certain words generally used to describe defects in the 

Comments.   

 
These words can be changed in the Hot Scan Keywords box.  Left clicking on the Hot 

Scan checkbox will turn off and on the Hot Scan.  Right clicking on the Hot Scan 

checkbox will bring up the Hot Scan Keywords list.   

 



Edit comments later by using comment button on right 
To change comments later, click on the Comment button in the corresponding row at the 

right of the screen.  The comment button is dark gray if there is no comment, light gray if 

there is a comment, and yellow if there is a picture. 

 

Flag for Photos and/or Additional Comments 
Flag all systems and subsystems requiring photos or additional comments.  

 

Next incomplete system or uninspected subsystem 

To proceed to the next incomplete system, click the corresponding highlighted tab in the 

system bar.   

 
To find the next uninspected subsystem, click on the Next Uninspected Subsystem 

button.  

 

Go to next flagged subsystem 

Once all the systems are completed, click the Go To Next Flagged Subsystem button, to 

find systems and subsystems that need further comment, or pictures attached. 

 

Add pictures to flagged subsystems 

To add a picture to a subsystem, click on the Comment button on the right,  

 
and in the comment screen, click on the Add Photo button.   

 
For assistance in adding the picture, see the Photos section of help, above. 



 

 

Smart Spell check 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select the Tools menu, and click Spell Check or press Ctrl+S.  This will spell check all 

comments in your report. The system will review your comment pool to establish your 

commonly used words. You can also set how often this happens in the preferences under 

the general tab. 

 

 

 

 

 

 

 

 

 

 

 



Change the look of the main screen 
 

 
On the preferences screen, you can set the colors and system buttons and screen 

background to add style of high contrast. 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

Change text size and line height on main screen  

(Make things easier to see and/or be able to fit more on the screen) 

 

 
 

Preview report 

To preview your completed report, or a section of it, select the File menu, select Preview 

Screen and your option, or Preview All for the full report.  Your report will now be in 

PDF format.  Press page down to proofread report.  If you do not want a PDF created, 

this can be changed in the Tools/Preferences menu in Report Preferences. 

Save/Print/Burn to CD/e-mail 

This PDF report can be saved in RDF format, by selecting File and Save.  It can be saved 

in PDF format by clicking Export PDF.  The PDF file and all photos will be saved in a 

folder in the Inspectware directory.  The report can be printed either from the PDF 

preview screen, or by selecting File and clicking Print Summary, Print Report, or Print 

All.  The report can also be burned to CD.   



How to… 

Customization 

WARNING:  All customizations are permanent and global.  Added and removed 

Systems, Subsystems and Subsystem types are added and removed retroactively to 

all records. We recommend you back up hit.dx before making major changes.   

Showing Pictures in Reports 

 

Customizing Opinion Descriptions 

To customize the Opinion Descriptions, click Administrative and select Edit Opinion 

Descriptions.  The descriptions can be edited, and the order in which they are printed on 

the report can be changed.  Click Save to save changes. To choose what goes into the 

summary, if the hide box is checked than that group of items will not show in the 

Summary and will only appear in the Main Report (caution if there is a photo, the photos 

should be turned on in the Main Report or the photo will not be displayed in the report). 

The “none noted” header can be turned on for each type of item displayed in the 

summary if no items are selected in that level of opinion the header will be displayed. 

 

 



 
 

 

 

 

 

  

Customizing Systems 

To add a new System, click Edit and select Add a New System.  Enter the name of the 

new system, and click OK.  All new Systems must have both subsystems and subsystem 

types added.  New Systems are not automatically available on the report to comment on.  

To be able to make general comments about the system, a subsystem by that name must 

be added.  All pre-existing systems have subsystems by their name in all capitals. 

 



 

Customizing Subsystems 

To add a new subsystem either to a new System or to an existing System, click Edit and 

select Add a New Subsystem.  Select the System to which you want to add the 

Subsystem, enter the name of the subsystem and click OK.  Add more subsystems if 

desired, and click Done.  You will be prompted to rebuild the framework.  Click Yes 

when all desired subsystems have been added. 

 

Customizing Subsystem Types 

To add a new subsystem type, select the subsystem to add it to on the main screen.  Click 

Edit and select Add a New Subsystem Type.  Enter the name of the type and click OK.  

You will be prompted to rebuild the framework after each Subsystem Type.  Click Yes 

when all desired subsystem types have been added. 

 

Customizing Comment Pool 

An explanation of how to customize the Comment Pool can be found in the basic  

Comment Pool help section. 

 

Customizing the data collection screen 

Edit Framework Items 

To Customize the Framework of Systems, click Administrative and select Edit 

Framework Items.  Use the arrows on the right to sort and reorder the items.  Click Edit 

and Rename, Add, Duplicate   To delete a system, highlight that system, and right click 

on it, and select delete. 



 

Import/Export 

Insert Previous Report Data 

To insert data into the current report from a previous report, click Administrative, select 

Import/Export and select Insert Previous Report Data.  This will over-write all data 

currently in the inspection.  This is primarily useful for inspecting nearly identical 

houses, condos or apartment units, or for a second inspection of the same one. 

Export Current (N/A) Data 

To save the current data, which is a list of which systems are marked Not Applicable, 

click Administrative, select Import/Export and select Export Current (N/A) Data.  This 

will create an Inspectware File that can be imported into other Inspectware reports. 

Import (N/A) Template 

To import a previously saved data file, click Administrative, select Import/Export and 

select Import Boot Layout.  This will import a list of the systems that were marked N/A 

in the report the data was exported from.  If some systems were already inspected in the 

current report and marked as applicable, you will be prompted whether to mark them as 

N/A or not.  Clicking cancel will automatically mark all systems N/A that were marked 

N/A in the file.  Marking a system N/A that has subsystems selected and/or comments 

made will omit those subsystems and/or comments from the report. 

Export Comment Pool 

To Export the comment pool to an Inspectware Export File, click Administrative, select 

Import/Export and select Export Comment Pool.  This will create a backup of your 

current comment pool, which can be loaded into any copy of the Inspectware Software. 



Import Comment Pool 

To Import a comment pool from an Inspectware Export File, click Administrative, select 

Import/Export and select Import Comment Pool.  This will import the comments from 

that pool.  Comments can be combined or overwritten. 

Export Client Addresses  

To Export Client Addresses, click Administrative, select Import/Export, and select 

Export Client Address.  This will create a comma separated value file with the client 

addresses for all existing Inspections.  Excel and database friendly, separated values 

format. 

Export Referral Addresses 

To Export a Referral Address, click Administrative, select Import/Export, and select 

Export Referral Address.  This will create a comma separated value file with the referral 

Addresses for all existing Inspections.   

Export All (Client, Referral, Inspector) 

To Export All Client, Referral and Inspector information, click Administrative, select 

Import/Export and select Export All.  This will create a Comma Separated Value file with 

all client, referral and inspector addresses.   

Palm HipPocket has been removed from the product and 
will no longer be supported after 2014 



FAQs 

I recently purchased InspectWare V5/tablet addition. I use it on my 
home PC and my laptop. Is there a way to keep the framework 
synchronized so if I make changes to one I can export it to the other? 

Yes. In fact, all of your customizations and your reports are located in a single file: 

"hit.dx".  Make a copy of the hit.dx file and cut and paste it onto your laptop or PC 

computer. When you are finished making changes and/or updates, copy the hit.dx file 

back again. 

Is there a way to get better compression on my PDF files created in 
Inspectware? 

Yes, there is a free program called PDFCreator available at 

http://sourceforge.net/projects/pdfcreator/  Go to the site and click the Download link.  

Once installed, you can use it like you would any printer. Just select Print, choose the 

printer "PDFCreator" and the PDF will be created for you.  

I added a photo in the comments section, why didn't it appear in the 
report? 

You have the option of showing pictures in the Summary and in the Main Report. Go to 

Tools -> Preferences -> Reports (tab) and check the Report Pictures options check boxes.  

 How do I change the look of the printed report? 

You can change the look of the report by going into the Report designer located in View -

> Preferences -> Reports (tab) -> Report Designer (button). This will let you change the 

color of the background from red in the Report Details. You can get rid of lines by 

changing the color to white. You can change the fonts, colors, sizes etc.  

PALM: I received the following error message when attempting to 
open-----------opensystemdatabase fail. try to hot synch system.pdb 
again. I have tried to re synch and it still does not work. any help 
would be appreciated 

You can try installing the files directly. They are located in the Palm folder, usually 

located at c\Program Files\InspectWare\Palm. Double click on the file: HipPocket_v1-

Install.prc or any file you want to install. You should then be prompted to choose a 

profile. HotSync. If that works, continue with all the *.pdb files.  

I get an error message when I open a comment pool and then save 
and close it that reads: Error opening dictionary file 
d:\progra~1\InspectWare 

You need to reset your dictionary location. You can do this by going to the menu View -

> Preferences. Select the General tab, and at the bottom, under Spell Check User 

Dictionary, click on the Set Location button.  You can navigate to the UserDic.tlx file in 

http://sourceforge.net/projects/pdfcreator/


your InspectWare folder.  You can also bring over your user dictionary from previous 

versions by copying the UserDic.tlx from another computer.  

I added a new SubSystem. Why doesn't it show up in the program?  

You need to reload the Screen Framework. Also, SubSystems need at least one Type to 

show up in the Report  

 


